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1 Introduction

ColorAdept is a brand-new LED control software committed to creating the ultimate
user experience. It supports three leading operating systems. Equipped with an
aesthetic user interface and strong color processing capabilities, it is designed to bring

an easy-to-use, intelligent, and efficient operation experience for users.

» Cabinet library
The cabinet library covers the common cabinet types, which is convenient for users to

select quickly.

» Color processing
It is designed to provide three color processing tools Color magic, Curves, and 3D LUT,

which is easy for users to adjust colors quickly and accurately to present rich creativity.

* Frame multiplexing & ShutterLock
The new virtual shooting methods achieve more creative concepts which presentin a

more realistic way.

e Multiple processors control
The parameters of multiple processors can be set simultaneously, which greatly

improves the user's work efficiency.

2 Installation

2.1 Installation for Windows PC

Step 1 Download the Windows installation file from the official website:

https://www.lednets.com/Support/Software/index.html

Step 2 Open the downloaded file to enter the Setup wizard.


https://www.lednets.com/Support/Software/index.html
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ColorAdept

Figure 2.1-1 Install now

Step 3 Select the Install now button or Customize button to continue.

B sccep

C:\Program Files\ColorAdept\

Figure 2.1-2 Install location

Step 4 When the software has finished installing, click the Start button to launch it
directly.

<9

>

ColorAdept

Figure 2.1-3 Finish
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2.2 Installation for macOS

Step 1 Download the macQOS installation file from the official website:

https://www.lednets.com/Support/Software/index.html

Step 2 Drag or copy the downloaded file into the application folder to complete

installation.


https://www.lednets.com/Support/Software/index.html
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3 Quick Start

3.1 Connecting Processors

Connect processors with a computer through the network cable or ethernet switch to

the same network segment.

m

J
Z8t 8t
25t 78t Z8t

Figure 3.1-1 Multiple processor connection diagram

3.2 Cabinet Library Configuration

Step 1 Select an online processor in the Discovered tab of the processor list to enter

the project management interface.

Menu bar Function bar

Processor list Projecf'fiie list

Figure 3.2-1 Project management



r'||:':iCOIorlight ColorAdept User Manual

Step 2 Select Settings from the function bar to enter the settings interface.

Step 3 Open the Cabinet Library tab.

Resolution Maximum frame rate

Figure 3.2-2 Cabinet library tab
Step 4 Click the Manage Packs button to enter the cabinet packs interface.

Step 5 Check whether the cabinet packs meet the requirements. If you need to add a
new pack, click to add it.

+o00o8

Figure 3.2-3 Cabinet packs

3.3 Create New Project
Step 1 Select the online processor in the Discovered tab of the processor list.

Step 2 Select the New button in the function bar to enter the new project interface.

Figure 3.3-1 New project
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Step 3 Set canvas size.

Step 4 Click the Create button to create a new project and enter the main project

interface.

Canvas view Pipeline area
° *
w |

Auxiliary area Prope area

Figure 3.3-2 Main project

3.4 Add Inputs
The maximum number of inputs depends on the processor type.
Step 1 Click Layout in the pipeline area.

Step 2 In the Layout properties area, click Custom in the inputs drop-down box or click

to enter the layout mode.

Layout mode
.

Figure 3.4-1 Layout mode
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Step 3 Modify the position or size of the input window in the main view of the layout

mode.

3.5 Add Cabinets

Step 1 Click the Add cabinets button in the toolbar of the canvas view to enter the Add

cabinets mode.

Main view Cabinet library properties
® ®

LIBRARY

DRAW ARRAY

L L ]
Ports Draw array properties

Figure 3.5-1 Add cabinets mode
Step 2 Select the type of cabinet that is the same as the actual connected cabinets.
Step 3 Select the appropriate port under the Ports tab.

Step 4 Click + drag to add cabinets in canvas area, the topology of the cabinet is

defined by the direction of dragging.

Step 5 The topology of the newly added cabinets can be modified quickly in the Draw
Array properties.

Topology

Figure 3.5-2 Topology
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4 Processor List

The processor list is mainly applied to select the desired processor or processor group,

which consists of the Discovered and Simulator tabs.

You can browse the processor information, add or delete processors, add or delete
processor groups, search for processors, import or export, and perform other

operations. This chapter takes the Discovered tab as an example.

Simulator

Discovered

Processor display area

Toolbar &

Figure 4.1-1 Processor list - Discovered tab

When you select two or more processors, the multiple processors control interface will

be displayed.

DNote:

When the group node is selected, all processors in the group are selected by default.

= Refresh : Click this button to refresh the processor display.
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4.1 Processor List

From top to bottom, it is displayed as all processors, groups, and processors.

~ [l All processors(1)

B Group 1

s~ @ Simulator

Figure 4.1-2 Processor list
The node information are as follows:
» Group: Group name, processors.

» Processor: Type, IP, Project, UID.

4.2 Toolbar

From left to right, there are the menu button, add group button, add a processor

button, and delete button, as shown in the following figure:

Figure 4.2-1 Toolbar

. : Create a group in the processor list. Move any processors requiring unified

parameter adjustments into the same group.
. : Click to add a processor.
. E: Delete the selected processors/groups.

. E: Click the menu button to pop up the menu list as shown in the following

figure:

()} Search

2] Im port

:. » Fx po rt

Figure 4.2-2 Menu list
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< Search: Search for processors under the current tab and support fuzzy search of

the processor name, type, or IP.
< Import: Import a configuration file stored on your computer to the processor list.

< Export: Export the configuration (group and processor information) of the

processor list to your local disk.

4.3 Context Menu
When you select a single processor or multiple processors, the following options are
displayed.
Rename Rename the processor.
c Create a new group and move the processor(s) to the new
rou
P group (for the processor(s) which is/are not in any groups).
Move to
Move the processor(s) to the target group.
group

Remove from
Remove the processor(s) from the group.

group

Delete Delete the selected processor.

When you select a single group, the following options are displayed.

Rename Rename the group.
Remove the processor(s) from the group and delete the
Ungroup
group.
If the group contains at least one processor, selecting
Delete will delete the group and all processors within it,
Delete while selecting Ungroup will remove the processors from

the group and delete the group.

If the group has no processors, it will be deleted directly.

Page 10
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When multiple groups are selected or processors and groups are selected

simultaneously, the following options are displayed:

Function Description

Remove the processor(s) from the group and delete the
Ungroup

group.
Delete Delete the selected group and all processors in the groups.

5 Project Management

Project management is mainly used to create, import, export, and switch projects.

Projects files are stored in the memory of the processor.

5.1 History Project

Prerequisite: An online processor is selected in the processor list and there is no

project file opened.

Function bar

Project file list

Figure 5.1-1 History project

Function bar

. : Click to enter the new project interface.

. : Click to open the file browser window and import a .capf file stored on your

computer to the processor.

11
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. : It is available, only when one project file is selected. Click to open the file

browse window and select the location to save the file to your computer.
. : Click to enter the settings interface.
. : Click to enter the log interface.

Project file list

* Project name: It displays the project file name.

= Last used time: It displays the last used time of the project file and clicking this

heading toggles the project list in ascending/descending order.

» File size: It displays the size of project file.

= Search bar: You can fuzzily search the project name in the project file list.

When you hover the cursor over a project file, the following three buttons will appear.
. E: Click to open the project file and then enter the main project interface.

. : Click to rename the project file.

. Click to delete the project file.

5.1.1 Open Project

Three ways can be applied to open a project.
» Method 1: Double-click the project file.

= Method 2: Hover the cursor over a project file and click the Open button E among
the three buttons displayed.

» Method 3: Right-click on a single project file and select Open in the context menu.

5.1.2 Rename Project

You can rename a project in two ways.

» Method 1: Hover over a project file and click the Rename button among the
three buttons displayed.

» Method 2: Right-click a single project file and select Rename from the context

menu.

12
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5.1.3 Delete Project

There are three ways applicable to delete a project.

» Method 1: Hover over a project file and click the Delete button 58l among the three
buttons displayed.

» Method 2: Right-click the project file, select Delete in the context menu and you can

press Ctrl + click if you need to select more.

» Method 3: Select a project file and delete it by pressing the Delete button and you

can press Ctrl + click if you need to select more.

5.2 New Project

Project name

Z8t Project 2023-07-04 19-04-44

Canvas

Figure 5.2-1 New project

Create a new project by clicking the New button on the function bar from the
History Project interface. Follow these steps to enter the main project interface.

Step 1: Enter a project name.

Step 2: Set a suitable canvas size.

Step 3: Select whether to turn on processor/cable redundancy.

Step 4: Click Create to enter the main interface of the project.

DNote:

The project is automatically saved to the memory of the processor.

13
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6 Settings

The settings interface allows you to set the processor parameters, view the processor
status, manage the cabinet library, set health options, and update the processor

program.

Click Settings from the function bar of the history project interface to enter the
settings interface. If the project is already opened, you can also click Settings from the

Tools menu in the toolbar.

Figure 6.1-1 History project toolbar

6.1 Processor Information

You can view the firmware, hardware, network, and temperature in the Processor

information tab.

Cabinet library Update

Figure 6.1-2 Processor information

14
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6.2 Processor Settings

srmation P Cabinet library  Update

Restore factory settings

Figure 6.2-1 Processor settings

General

=  Processor name: It can be customized.

General

Figure 6.2-2 General

Network

The default IP address of the processor is 192.168.1.10, with a subnet mask of
255.255.255.0. The processor be configured either with a static IP address or an IP
address allocated by a DHCP server. To ensure proper communication between the
processor and the computer, each device within the same network should be assigned

a unique IP address.

Figure 6.2-3 Network

15
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Cabinet

Identify behavior offers two options:
= Frontidentify & Rear indicators

* Only rear indicators

Front identify 8 Rear indicators

Figure 6.2-4 Cabinet

Restore factory settings

Before restoring the factory settings, users can save the IP address.

Restore factory settings

Figure 6.2-5 Factory reset

EdNote:
Restore factory settings will delete all project files, imported cabinet packs, other resources

imported to the processor, and reset the processor settings.

6.3 Cabinet Library

To establish normal communication with cabinets and identify their properties, the

cabinet packs should be placed in the cabinet library for better management.

Cabinet pack: (.cbp) Compilation of cabinet firmware. Public release will include all

updated public cabinets to the date of release.

Cabinet library: A group of cabinet packs installed in a processor.

DNote:

All processor firmware releases contain the latest cabinet pack at the time of release.

16
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Health settings  Update

Status wision urce Resolution Maximum frame rate

Figure 6.3-2 Cabinet pack management

Cabinet pack list

The listed packs are sorted by the creation time with the highest priority at the top of
the list. The priority can be changed by dragging the desired cabinet pack above

another one which contains the same cabinet type.
Cabinet pack management

R Click to add the selected cabinet pack to the processor.
@]: Click to delete the selected cabinet pack.

[: click to export the selected cabinet pack.

: Move the selected cabinet pack up to raise its priority.
[B]: Move the selected cabinet pack down to lower its priority.

[®): Restore the cabinet library to its default settings. All user-added cabinet packs will
be deleted.

& Download cabinet pack from the Cloud.

LdNote:
If a cabinet type exists in multiple cabinet packs, by default the one in the highest priority packs is

used.

17
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6.4 Health Settings

Health settings allow you to select monitoring of video input, cabinet video input,
cabinet connection status, module wiring, network cable error rate, receiver's
temperature/humidity/voltage/power supply/fan/dead pixels of a module, and set up

email notification.

E I EEEES

Figure 6.4-1 Health settings

= Always display health data
You can select the checkbox to keep health data visible on the cabinet/module with
always-on display.

General

. Always display health data

Figure 6.4-2 Always display health data

= Processor video input
You can choose to enable the processor video input, which allows monitoring of the

input resolution and frame rate.

18
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Input

B 1-Homi
B 1-Hpmi2
(] 2-pP1

[]2-pp2

Figure 6.4-3 Processor video input

= Cabinetvideo input

You can select the checkbox to monitor cabinet video input.

- Cabinet video input

Figure 6.4-4 Cabinet video input

= Cabinet connection status

You can select the checkbox to monitor the cabinet connection status.

. Cabinet connection status

Figure 6.4-5 Cabinet connection status

* Module wiring

You can select the checkbox to monitor the module wiring.

n Module wiring

Figure 6.4-6 Module wiring

= Network cable error rate

You can select the checkbox to monitor the network cable error rate.

- Metwork cable error rate

Figure 6.4-7 Network cable error rate

= Receiver
You can select the desired checkboxes to monitor the temperature, humidity, voltage,

power supply, and fan.

19
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Figure 6.4-8 Receiver

= Pixel
You can choose to detect the dead pixels on a module, with three modes available.

Pixel

. Dead pixel of a module over  5px alert
1eck once every = 60min automatically

O Check once yat 1800 © | automatically

O Check manually

Figure 6.4-9 Pixel

» Email settings

You can choose to receive email alerts and abnormal recovery notifications.

Email settings

[ ] Email notification

|:| Rec ¥ notice

Figure 6.4-10 Email settings

To configure the email settings, complete the information for the sender and the

recipient.

Recipient mail

MName

Figure 6.4-11 Mail information

20
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6.5 Update

Upgrade the processor firmware program. After the update is completed, you need to

power off and restart the processor.

Figure 6.5-1 Update interface

* Importing update file
< Click on the upload area below File to open the file browser window, and

select the update file.
< Alternatively, select a local update file, then drag and drop it to the upload

area.

Click the Update button to starting upgrading.

Figure 6.5-2 Update

» Update list

< This list appears only after you enable the Advanced mode and import the

update file.

< You can select the checkbox for the board which needs updating.

21
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7 Main Project Interface

Creating or opening a project takes you to the main project interface, which has three

view modes of Canvas, Device, and Health.

Menu bar View area Pipeline area
1258 Cooridiet * ?

s ) s
Processor list Status bar Auxiliary area Property area

Figure 7.1-1 Main interface

7.1 Menu Bar

7.1.1 ColorAdept Menu

Selecting ColorAdept in the menu bar displays the following options.
(% About ColorAdept

=] User manual

iz Shortcuts Ctrl+Alt+K

iii Capacity calculator

Preferences... Ctrl+,

Quit ColorAdept Ctrl+Q

Figure 7.1-2 ColorAdept menu

About ColorAdept



rE'COIorlight ColorAdept User Manual

After clicking ColorAdept, the information of the software is displayed, such as the

build number, build time, license, copyright, etc.
Shortcuts (Ctrl + Alt + K)

Click to open the shortcuts interface of ColorAdept.

°
Shortcuts interface

Figure 7.1-3 Shortcuts interface

The shortcuts in the ColorAdept tab are as follows:

Figure 7.1-4 ColorAdept tab

= Shortcuts: Ctrl + Alt + K (macOS: #~ K)
= Preferences: Ctrl +, (macOS: 38,)
= Quit ColorAdept: Ctrl + Q (macOS: Q)

The shortcuts in the Project tab are as follows:

23
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Figure 7.1-5 Shortcuts in Project tab

= Save as: Ctrl + Shift + S (macOS: 1 $£S)
= Save a copy: Ctrl + S (macOS: 3£S)
= Close: Ctrl + F4 (macOS: &EW)

The shortcuts in the Edit tab are as follows:

Undo Ctrl Z Select all

Redo Group

Copy C Ungroup

Paste V Delete

Figure 7.1-6 Shortcuts in Edit tab

= Undo: Ctrl+Z (macOS: #£Z7)

» Redo: Ctrl +Y (macOS: &Y)

= Copy: Ctrl + C (macOS: #£C)

= Paste: Ctrl +V (macOS: V)

= Select all: Ctrl + A (macOS: &£A)

= Group: Ctrl + G (macOS: &G)

= Ungroup: Ctrl + Shift + G (macOS: {t 3£G)
» Delete: Delete (macOS: Delete)

The shortcuts in the View tab are as follows:

Figure 7.1-7 Shortcuts in View tab

24
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= Zoom out: Ctrl + - (macOS: &-)

= Zoom in: Ctrl ++ (macOS: &£+)

= Zoom 1:1: Ctrl + 0 (macOS: 3£0)

= Zoom to fit: Ctrl + F (macOS: &£F)

= Toggle navigator: Ctrl + Shift + N (macOS: {1 EN)
= Edit: Ctrl + F1 (macOS: #£F1)

= Heat map: Ctrl + F3 (macOS: 3£F3)

The shortcuts in the General tab are as follows:

Figure 7.1-8 Shortcuts in General tab

» End current task: Esc
» Zoom in and out: Ctrl + Wheel (macOS: EWheel)

» Panthe view: Space + Drag

The shortcuts in the OSCM - General tab are as follows:

R

Figure 7.1-9 Shortcuts in OSCM - General tab

= Select horizontal and vertical seams: F1

» Select horizontal seams only: F2

» Select vertical seams only: F3

= Select seams on panel edges: F4

» Select horizontal seams on panel edges: F5
» Select vertical seams on panel edges: F6

= Display white: A

» Displayred:S

» Display green: D

25
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= Display blue: F

» Displaycyan: G

= Display magenta: H
= Display yellow: J

» Display video: V

The shortcuts in the OSCM - Seam tab are as follows:

General

Figure 7.1-10 Shortcuts in OSCM - Seam tab

* Luminance: 1 + Left/Right arrow
= Start luminance: 2 + Left/Right arrow

* End luminance: 3 + Left/Right arrow
Capacity calculator

This tool is designed for calculating the load capacity of an port.

Capacity calculator

Frame rate

-~

10.36%

Cabinet ) Pixel

256

Figure 7.1-11 Capacity calculator

Preferences (Ctrl +,)

Click ColorAdept > Preference to open the preferences interface.

26
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Preferences interface

Figure 7.1-12 Preferences interface
» General

Show Fahrenheit ( °F): Tick the box to show temperature in Fahrenheit ( °F). If

unselected, temperature will be displayed in Celsius (°C).

General

e Canvas

Figure 7.1-14 Canvas

= Show grid: Tick the box to show grid dots. It is allowed to set the grid spacing
in the drop-down menu of canvas properties.

= Snap to grid: Tick the box to pull the cabinets into perfect alignment with the
grids.

= Snap to cabinets: Tick the box indicates even alighment between every

27
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cabinet, avoiding overlapping or small gaps.

» Show cabinet index: Tick the box to display the index of each cabinet.

» Cabinet selection mode

Cabinet selection mode

{(®) Inside selection area

Cherlaps selection area

Drag direction mode

Figure 7.1-15 Cabinet selection mode

* Inside selection area: This option is selected by default. The selection box
must completely enclose cabinets to select them.

= Overlaps selection areas: Click to select this option. A cabinet can be selected
if any part of the cabinet is within the selection area.

= Drag direction mode: Click to select this option. Dragging from left to right
selects cabinets that are completely within the selection box. Dragging from right

to left to select cabinets at least partially inside the selection area.

e Advanced

Advanced

[[] Chief-Member mode

|:| Advanced mode

Figure 7.1-16 Advanced mode

= Advanced mode: Tick the box Advanced mode to make the hidden advanced

functions available.

* Language

The interface language is allowed to be set as Chinese or English currently.

7.1.2 Project Menu

Select Project in the menu bar to bring up a drop-down menu. See Figure 7.1-17.
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Ctri+Shift+5

| Save a copy... CErES

Sync to processor

Cloze

Figure 7.1-17 Project menu

» Save as: Save the project to the processor, and the currently opened project will be

displayed as the saved project.

» Save as a copy: Save the project to the local disk.

* Sync to processor: Sync the project to another processor.

» Close: Close the current project and navigate to the project management interface

of the current processor.

7.1.3 Edit Menu

Click Edit in the menu bar to open a context menu with a list of options as follows.

Figure 7.1-18 Edit menu

* Undo: Undo the last action performed.
* Redo: Redo the last action performed.

» Copy: Copy the cabinets without copying its values in the override properties.
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» Paste: Paste the cabinets.

 Edit topology: Modify topology connections between added cabinets.

* Cleartopology: Clear the topology connections of the selected cabinets.
» Select all: Select all cabinets in the canvas.

* Group: Make a group with the selected cabinets.

* Ungroup: Break the selected groups.

Delete: Delete the selected cabinets.

7.1.4View Menu

Click View in the menu bar to open a context menu with a list of options as follows.

@ Toggle navigator Ctrl+5hift+N

OF Edit Ctrl+F1

O Heat map Ctri+F3

Figure 7.1-19 View menu
e Zoom out: Adjust the view of the canvas to show smaller.
» Zoom in: Adjust the view of the canvas to show larger.
» Zoom 1:1: Adjust the zoom to display the canvas with a 1:1 resolution.

e Zoom to fit: Adjust the zoom and view position to display the full size of the canvas

in the center of the screen.

» Zoom to selection: Adjust the zoom and view position to fit the selected cabinets in

the center of the screen.
» Toggle navigator: Show or hide the Navigator window.

» Edit: Edit mode is the default mode of canvas, in which cabinets are displayed as

viewed from the front.
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* Heat map: Display cabinets on the canvas which is colored based on the

temperature reported by the internal sensors.

7.1.5 Tools Menu

Click Tools in the menu bar to open a context menu with a list of options as follows.

{33 Settings

® Dynamic color gamut
B
oo OSCM

e Export device layout...

S Import device layout..

=) Print canvas layout...
Figure 7.1-20 Tools menu
» Settings: Click to open the Settings interface.
» Dynamic color gamut: Click to open the Dynamic color gamut interface.
¢ OSCM: Click to open the On-screen color management interface.
» Export device layout: Export the cabinet layout of the processor.
» Import device layout: Import the cabinet layout of the processor.

* Print canvas layout: Click to open the Print canvas layout interface. You can

customize the watermark, table header, and other settings before printing.

Figure 7.1-21 Print interface
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7.2 Pipeline Area

The pipeline represents the signal flow of color processing through the processor.
Each pipeline tile possesses its corresponding properties. Pipeline tile properties can

be viewed by clicking on a tile to prompt the property editor to appear.

Pipeline area
— i

Figure 7.2-1 Pipeline

The pipeline area is composed of INPUTS, PROCESSING, OVERRIDE, and OUTPUT.

The INPUTS tab contains LAYOUT and ADJUSTMENT tiles.

= LAYOUT: It displays a scaled-down thumbnail of the canvas and layers in the
layout mode.
= ADJUSTMENT: It displays the selected layer(s) for adjustment.

The PROCESSING tab includes COLOR MAGIC, CURVES, and 3D LUT tiles.

= COLOR MAGIC: It displays the switch status and the modified colors.
= CURVES: It displays the switch status and the color curve.
= 3D LUT: It displays the switch status and the color intensity.

The OVERRIDE tab involves PATTERN, FREEZE, and BLACKOUT tiles.

= PATTERN: It displays the switch status and the selected test pattern.
= FREEZE & BLACKOUT: It displays the switch status only.

The OUTPUT tab is comprised of COLOR, NETWORK, and FAILOVER tiles.
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*COLOR: It displays the current brightness value, intensity gain, red gain, green

gain, and blue gain.

*NETWORK: It displays the network bit depth, frame rate, and system load of the

current processor.

< Network bit depth: It displays the current output color depth.

< Frame rate: The displayed frame rate is affected by the settings of

Genlock and Frame rate multiplication in the property area.

< System load: It displays the current system load status. Hovering the

mouse over the load bar reveals the load percentage.

*FAILOVER: It displays the current backup status.

You can enable tile functions by double-clicking the corresponding tiles included in

the PROCESSING and OVERRIDE tabs.

You can select multiple tiles by clicking while pressing and holding Ctrl. Properties in

the selected tiles will be displayed orderly in the property editor from top to bottom.

7.3 Property Area

The property area is located on the right side of the main project screen. Relevant

properties will be displayed based on the user's operations.

Property area
L ]

Figure 7.3-1 Property area

The property area can be shown/hidden by clicking the lll button.
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The property area displays the corresponding toolbar buttons according to different

properties.

e Hide/Show .: Hide or show the properties.

* Enable n: Click to enable the current properties.

* Reset : Reset the values in the current property area to its default values.
e Pin : Pin and fix the current properties to property area.

e Close .: Close current property area.

7.4 View Area

7.4.1 Canvas View

In the canvas view, you can perform operations such as adding/deleting cabinets,
editing/deleting cabinets topologies, setting canvas properties, adding/deleting tiers,

and grouping/ungrouping.

Toolbar
L ]

[ ]
Main view

Figure 7.4-1 Canvas view

Canvas toolbar

e Undo .: Click to undo the last action performed (A prompt of the action is

displayed when hovering over the button).

¢ Redo .: Click to redo the last action performed (A prompt of the action is

displayed when hovering over the button).
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» Add cabinets : Click to enter the Add cabinets mode.

» Edittopology : The cursor will turn into a pen after clicking this button.

=L eft-click cabinets to add a topology for cabinets without a topology defined.
*Right-click a cabinet to clear the topology for the cabinet and cabinets after it.

| eft-click and drag the cabinets without a topology defined, then the topology
will be applied according to the dragging order.

»To exit edit topology mode, right-click no-cabinet area.
» Cleartopology E: Delete the topology of the selected cabinet.
e Zoom out : Adjust view of the canvas to appear smaller.
e Zoomin : Adjust view of the canvas to appear larger.
e Zoom1l:l : Adjust the zoom to show the canvas with a 1:1 resolution.

e Zoom to fit : Adjust the zoom and view position to display the full size of the

canvas in the center of the screen.

e Zoom to selection : Adjust the zoom and view position to fit the selected

cabinets in the center of the screen.

» Toggle navigator H: Show or hide the navigator window.

Canvas edit mode

Click the in the upper-right corner of the view area or select the
corresponding option of the View menu from the menu bar to switch the canvas view

mode.

e Edit mode: It is the default mode for canvas view, where the cabinets are displayed

as viewed from the front.

Canvas properties

Open the canvas properties by clicking in the canvas toolbar.
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CANVAS PROPERTIES

Size

3840x2160

Background

Perimage pixel

Colar Spacing

E Cabinets edit enabled

Figure 7.4-2 Canvas properties
» Canvas size: Customizable within maximum load limits.

» Background

»Support to hide or show background.
=Support importing image file types of JPG, PNG, GIF formats.
=Support the operation of the imported image for upper-left position adjustment,

zooming and clearing.
* Grid: Support to modify the color and spacing of grid.

» Canvas edits enabled: You can set whether to allow modification of cabinet

position in the canvas view.

Tier properties

Tiers provide an easy way to manage cabinet overlapping by assigning cabinets to

tiers with different z-orders which indicates the tier order from top to bottom.

Open tier properties by clicking =l in the canvas toolbar.
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o Al

& Tier 5 {Current)

Figure 7.4-3 Tier properties

» Add: Add a top tier of Z-order.

» Delete: Delete the currently selected tier.

» Show/Hide tiers: Toggle the show/hide status of tiers.
* Rename: Double-click a tier to rename it.

 Tier priority: Drag a tier up or down to adjust its Z-order.

Library properties

In the Add cabinets interface, the cabinet properties will be displayed in the properties

area, which include:

» LIBRARY: Display the cabinet types, resolutions, and maximum frame rates.

Resolution  Maximun

Figure 7.4-4 Library properties

» Cabinet information: Right-clicking on a desired cabinet type to access its Basic
information, Module information, Performance information, Advanced information,

and other supported features.
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L

TVF0.9

Basic information Meodule information

Performance information

Advanced information

Figure 7.4-5 Cabinet information

Array properties

After adding a cabinet in the Add cabinets interface, the array properties will be

displayed in the property area, which include:
* Group cabinets: Support adding cabinets in group.

» Topology: Provide eight topologies for quick setup.

Position: Display the current cabinet position and support adjustment.

Size: Support adjusting the number of columns and rows when adding cabinets.

Spacing: Support adjusting the horizontal and vertical spacing when adding

cabinets.

DRAW ARRAY

Position

600

Figure 7.4-6 Array properties
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Cabinet properties

When you click on a cabinet that has not been grouped in the canvas view, the
properties of the cabinet will be displayed in the properties area which includes the

information as follows.

« Cabinet information: Display the manufacturer, type, resolution, maximum frame

rate and group name of the cabinet.

CABINET

Manufacturer ColorLight

Max framerate Upto 61Hz

Group  Ungrouped
Figure 7.4-7 Cabinet information

* Alignment: Support eight alignment modes for cabinets or cabinet groups, which
are align left, align horizontal centers, align right, distribute horizontal spacing, align

top, align vertical centers, align bottom, and distribute vertical spacing.

Alignment

S % 20/ 00 g8 I =

Figure 7.4-8 Alignment

» Topology: Eight cabinet topologies available for quick setup.

Figure 7.4-9 Topology

 Position: It displays the cabinets position, which can be locked to prevent editing.
Position

|:| Lock to prevent edits

Figure 7.4-10 Position
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Overrides properties (Cabinets)

OVERRIDES

g Owverride global gains

Intensity gain

Red gain

Green gain

Blue gain

Figure 7.4-11 Overrides
* Override global gains: It means applying independent intensity gain and RGB gains
for the selected cabinet, regardless of global gain.
Device properties

» Device information: It displays the S/N and firmware version of the cabinet.

DEVICE

Firmware i9V1.00

Figure 7.4-12 Device information

» Enable beacon: It activates the "beacon" test mode of the selected cabinets. When
the beacon of panel is enabled, the status indicator on the back of the panel flashes

faster.

|:| Enable beacon

Figure 7.4-13 Enable beacon

Group properties

When a cabinet group is selected in the canvas view, the cabinet group properties are

displayed in the properties area.
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* Name: It displays the name of the cabinet group and supports modification.

» Color: It displays the color of the cabinet group. Clicking on it will open the color

selection panel and the selected color will be used as the border color of the group.

GROUP

Marme

Group 1

Figure 7.4-14 Cabinet group

» Alignment: Support eight alignment modes for cabinets or cabinet groups, which
are align left, align horizontal centers, align right, distribute horizontal spacing, align

top, align vertical centers, align bottom, and distribute vertical spacing.

Alignment

S 000 fe o=

Figure 7.4-15 Alignment

» Topology: Eight cabinet topologies available for quick setup.

Figure 7.4-16 Topology

* Position: It displays the cabinets position, which can be locked to prevent editing.
Position

|:| Lock to prevent edits

Figure 7.4-17 Position

» Overrides properties (Cabinet groups)

= Override global color: It indicates that you can apply independent brightness

and color temperature for the selected cabinet groups, regardless of global color.
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OVERRIDES

Override global color

Erightness 1000Mits

Color temperature

Figure 7.4-18 Override global color

* Override global gains: It means that independent intensity gains and RGB gains can

be used for the selected cabinet groups, regardless of global gain.

ride global gains

Intensity gain

Red gain

(Green gain

Blue gain

Figure 7.4-19 Override global gains

Context menu

» When you select one cabinet or multiple cabinets, the following options are

displayed.
Function Description
Copy Copy the selected cabinets.
Paste Paste the cabinets to the current position of cursor.
Group Make a group of the selected cabinets.
Ungroup Break the group of current cabinets.

Add to group | Add selected cabinets to the group.

Remove from | Remove the selected cabinets from the group (Hold the

group Shift key to select a cabinet within the group).

42



I Colorlight

ColorAdept User Manual

Select string

Select all cabinets connected to the same string as the

selected cabinet.

Delete topology

Delete topology of the selected cabinets.

Select cabinets

with same type

Select all cabinets of the same type as the selected

cabinet.

Send to back

Send to the back of the z-axis of the selected tier.

Move to tier Move the selected cabinets to a tier.
Change type... | Change the type of the selected cabinets.
Zoom to Zoom and position the canvas so that the selected
selection cabinets are in the center of the canvas view.
Delete Delete the selected cabinets.

When selecting a cabinet group, the following options will appear.

Copy Copy the selected cabinet group.
Paste the cabinet/cabinet group to the current position
Paste of cursor.
Ungroup Break the current cabinet group.

Select grouped

cabinets

Select all cabinets in the current cabinet group.

Delete topology

Delete topology of the selected cabinet group.

Send to back

Send to the back of the z-axis of the selected tier.

Move to tier Move the selected cabinet group to a tier.
Zoom to Zoom and position the canvas so that the selected
selection cabinet group is in the center of the canvas view.

When you click on an area outside the cabinet/cabinet group in the canvas view,

the following options are displayed.

Paste

Paste the cabinet/cabinet group to the cursor position.
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Adjust zooming and position to show the full view in the

Zoom to fit
center of the canvas.
Adjust the zoom to show the canvas with a 1 to 1
Zoomtol:1 ) ]
resolution of the display.
Toggle . , ,
_ Show or hide the navigator window.
navigator
Show group )
Group names can be shown or hidden.
name
Group grid Grid dots can be shown or hidden at convenience.

Pull cabinets into perfect alignment with the grid. Is
Snap to grid enabled by default, helping to align or space cabinets

evenly on the canvas.

Pull cabinets into perfect alignment with other cabinets.
Snap to cabinets | Is enabled by default to align cabinets evenly on the

canvas avoiding overlapping or small gaps.

Canvas edits

Enable or disable modification of the cabinet position.
enabled

7.4.2 Device View

Device view shows the output port status of the current processor, and the detailed

information of the connected cabinets and fiber optic transceivers.

Errors/Total packets ) Temperature  Work time Status

Figure 7.4-20 Device view- Cabinet topology
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» Cabinet topology view
It indicates the connection status of output ports. Green (number of cabinets) means

the port is connected and gray shows unconnected status.

e Cabinet list

It displays information about cabinets, including the output port connected, string

position, type, S/N, cable error, temperature, work time, and status.
* Reload firmware: Update the firmware of the selected cabinet.
* Reload parameters: Reload the parameters of the selected cabinet.

. : When Advanced mode is enabled, this icon will appear. You can click the icon

to switch between cabinet topology and fiber optic transceiver topology.

i | Device

Topology view

Figure 7.4-21 Device view- Fiber optic transceiver topology

» Fiberoptic transceiver topology

The topology shows the connection status of the fiber optic transceiver. The fiber

optic transceiver icon B will only appear under a port icon when the port is

connected to a fiber optic transceiver.

* Fiber optic transceiver list

This list shows information of the fiber optic transceiver, including the fiber port

connected, type, firmware version, and cable errors (errors/total packets).

dNote:

When Advanced mode is enabled, “Cable error” in the list will be replaced by “Errors/Total

packets” .

7.4.3 Health View

Health view provides the input status of the video and cabinet temperature, humidity,
cable error, voltage, power supply, fan, etc. It also provides monitoring reports for

users.
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Toolbar
®

@
Sidebar

Mai;view
Figure 7.4-22 Health view
Health settings

* Click in the sidebar to access Health settings.

Processor video input

* Click in the sidebar to view the video input, expected and actual resolutions

and frame rates.

» If the actual resolution and frame rate match the expected value, the actual value

will be displayed in green; otherwise, it will be displayed in red.

Expected Actual

Figure 7.4-23 Health view - Processor video input

Cabinet video input

» Click in the sidebar to view the video input, as shown by the legends indicating

health status (Normal, Error, Invalid, and Offline) at the upper-right corner.

Figure 7.4-24 Health view - Cabinet video input
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Cabinet connection

« Click B in the sidebar to view the cabinet connection. An error icon b appears

when connection failure occurs.

Figure 7.4-25 Health view - Cabinet connection

Module wiring

» Click in the sidebar to examine the module wiring, as shown by the legends

indicating health status (Normal, Error, Invalid, and Offline) at the upper-right corner.

Figure?7.4-26 Health view - Module wiring

Cable error

» Click in the sidebar to view the cabinet cable error, as shown by the legends

indicating health status (Normal, Warning, Error, and Offline) at the upper-right corner.

» The green cabinet indicates that the cable error rate is lower than 0.95/1,000,000.
Orange shows that the cable error rate has reached 0.95/1,000,000 and red represents
that the alarm value of 1/1,000,000 has been reached. Gray indicates an offline status

of the cabinet.
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Figure7.4-27 Health view - Cable error

Temperature

- Click K

indicating health status (Normal, Warning, Error, Invalid, and Offline) at the upper-

in the sidebar to view the cabinet temperature, as shown by the legends

right corner.

» The green cabinet indicates that the temperature is 95% lower than alarm value.
Orange shows that it has reached 95% of the alarm temperature and red represents
that the temperature alarm value has been reached. Dark gray means that the
temperature sensor of receiver is invalid or has an incorrect value, and gray indicates

an offline status of the cabinet.

Figure7.4-28 Health view - Temperature

Humidity
* Click @ in the sidebar to view the cabinet humidity, as shown by the legends

indicating health status (Normal, Warning, Error, Invalid, and Offline) at the upper-

right corner.

» The green cabinet indicates that the humidity is 95% lower than alarm value.
Orange shows that it has reached 95% of the alarm humidity value and red represents
that the humidity alarm value has been reached. Dark gray means that the humidity
sensor of receiver is invalid or has an incorrect value, and gray indicates an offline

status of the cabinet.
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Figure 7.4-29 Health view - Humidity

Voltage

» Click in the sidebar to view the cabinet voltage, as shown by the legends
indicating health status (Normal, Warning, Error, Invalid, and Offline) at the upper-

right corner.

» The green cabinet indicates that the actual voltage is 95% lower than alarm value.
Orange shows that it has reached 95% of the maximum voltage, and red represents
that the actual voltage has exceeded the alarm voltage value. Dark gray means that

the voltage of receiver is invalid, and gray indicates an offline status of the cabinet.

Figure 7.4-30 Health view - Voltage

Power supply

» Click in the sidebar to view the cabinet power supply, as shown by the legends

indicating health status (Normal, Error, Invalid, and Offline) at the upper-right corner.

Figure 7.4-31 Health view - Power supply



E‘-Colorlight ColorAdept User Manual

Fan

* Click ﬂ in the sidebar to view the cabinet fan, as shown by the legends indicating

health status (Normal, Error, Invalid, and Offline) at the upper-right corner.

Figure 7.4-32 Health view - Fan

Pixel
e Click in the sidebar to view the detection results of module pixels, as shown by
the legends indicating health status (Normal, Warning, Error, Invalid, and Offline) at
the upper-right corner.

= Pixel detection: Select E from the toolbar to examine dead pixel of the

current module.

Figure 7.4-33 Health view - Dead pixel detection of module

Report

* Click &= in the sidebar to view exceptions.
e Click to filter the abnormal data by type.

e Click to export the currently displayed abnormal data in CSV file format.
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Figure 7.4-34 Health view - Report

7.5 Auxiliary Area

The auxiliary area is located at the bottom of the main project screen.

L]
Auxiliary area

Figure 7.5-1 Auxiliary area

The auxiliary area contains three tabs of ports, presets, and logs.

7.5.1 Ports

The auxiliary area displays the ports tab by default. It is permitted to change the
cabinet color of ports and view related information. In add cabinets mode, select a

port first and then add a cabinet to the port.
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Figure 7.5-2 Auxiliary area - Ports

» 1G/5G toggle button: You can switch between 1G and 5G bandwidth for a port. This

function requires hardware support.

» The upper right corner of the ports tab displays the total number of used cabinets

in the canvas / the total number of detected cabinets.

» Each port is corresponding to a module and the information in the module is as

follows.

Figure 7.5-3 Port info

(DPort index.

(@Port cabinet color (support customization).

3 Total number of cabinets used in the canvas / Total number of detected
cabinets.

@pPercentage of port load occupied.

* In Add cabinets mode, you can click the port to add the cabinet to the

corresponding port.

e Context menu

Function Description

) Open the color picker and select the desired color to
Port color settings
apply to the current port.

Reset current port
Current port.
color
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Reset current port | Reset the cabinet color of the current port to default

color color.
Apply colortoall | Apply the cabinet color of the current port to all
ports ports.

Reset all port colors | Reset the cabinet color of all ports to default color.

7.5.2 Presets

Processor parameters can be saved as presets which is convenient to use later.

Figure 7.5-4 Auxiliary area - Presets

* Record button : Click to enter add presets mode.

Figure 7.5-5 Add preset mode

= The record button turnsinto an exit button I,

= Four icons are displayed next to the exit button, which are color o , position
* video ¥4 and dynamic color gamut ¥ select the corresponding icon for the

desired preset function, then click the preset tile below to save the preset and exit

add presets mode automatically.

= Click the exit button or press ESC to exit add presets mode.

Preseticon

* Preset color LS : Include Color Magic, Curves, 3D LUT, global color, cabinet/cabinet

group color (i.e. override properties).
e Preset position 7 : Record the position of all cabinets in current canvas view.

* Preset video ¥ : Record the input sources selected in the current output area
(including the properties, position, viewport area, zoom mode of viewport, zooming

and aspect ratio of each input source).
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* Preset dynamic color gamut v : Record the properties of the current dynamic

color gamut.

Preset tile

1 ‘@

Presetl

» o B D>

Figure 7.5-6 Preset tile

(DPreset index.

(@The status of the preset which displays as a white indicator when enabled.

(®Preset name and support customization.

@ Preset recorded parameters. If parameters have been recorded, it will display an
icon in the corresponding position. The first box represents the preset color; the
second represents preset position; the third represents preset video; and the fourth

represents preset dynamic color gamut.

7.5.3 Log

Click Log in the auxiliary area to be taken to the Log tab.

Figure 7.5-7 Auxiliary area - Log

* You can view and export operational records and errors that occur in the current

processor.
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8 Inputs

The inputs in the pipeline area consist of layout and adjustments tiles.
INPUTS

LAYOUT ADJUSTMENT

Figure 8.1-1 Inputs

8.1 Layout

8.1.1 Pipeline Tile

Without any sub-boards, the layout tile appears as follows.

Figure 8.1-2 Pipeline tile

If there is a sub-board inserted,
» When an input exists in the output area of the layout properties, the layout tile is

displayed as follows.

LAYOUT

Figure 8.1-3 Pipeline tile

« When no input exists in the output area of the layout properties, the layout tile is

shown as follows.

LAYOUT

Figure 8.1-4 Pipeline tile
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8.1.2 Properties

* Currently supported sub-board types:

SDIx2;
HDMIx2;
DPx2;
ST2110;
3IN1;

* The maximum number of inputs supported is determined by processor type.

Cropping

Cropping feature is used to crop the input sources.

» Cropping checkbox: When disabled, it displays the original size and position of the

source.

« Dimensions: It is applied to adjust the size and position of cropping area.

» Zoom mode: It is used after the inputs are cropped. It is defaulted as stretch mode,

you can choose 1:1 mode, fit mode, and fill mode.

Dhrmensions
Left Top

0 0
Width Height

3240 2160

Zoom mode

(1:1) Fit Fill Stretch

Figure 8.1-5 Viewport
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* Awhite dotted box indicates the cropping area.

Figure 8.1-6 Cropping area

Zoom mode

» 1:1 mode: The cropped video is at the same size as the original cropped image and

the top left vertex of the image is aligned with the input source window.

Figure 8.1-7 1:1 mode

e Fit mode: Zoom the cropped video to fit the input source window while

maintaining the aspect ratio.
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* Fill mode: Zoom the cropped video to fill the input source window while

maintaining the aspect ratio.

Figure 8.1-9 Fill mode

 Stretch mode: Stretch the cropped video to fill the input source window and match

the width and height of the window.

Figure 8.1-10 Stretch mode

Output area

Qutput area

Input

1-HDMI (12}

Figure 8.1-11 Output area
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» There are two ways to set layout mode of input sources.

» Select a quick option in the drop-down box, such as HDMI (1x2).
= Select Custom in the drop-down box or click on «— in input source window.
* Layout window

* The position and size of the inputs can be modified.

* Layer

» Layer No.: It displays the sequence number of layers.

= Lock/Unlock: Locks/unlock the layer.

* Drop-down list for input sources: Quickly select the input source.
= Zoom size can be set from left, top, width, height.

= Aspect ratio: Select an aspect ratio mode of zooming from Free, 4:3, and 16:9.

Layout mode

1-HDMIZ
3840x2160@60.000Hz

Figure 8.1-12 Layout mode

 Click HEEH to exit layout mode.
* Main view

» The canvas area is displayed in the center of the main screen.

= Support zooming and moving of the main screen.
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» When you right-click an input on the main screen, the following menu options are

displayed.
Function Description
Bring to front Bring the layer to the front.
Send to back Send the layer to the bottom.
Switch source Switch the selected input source to other sources.

Lock/Unlock position | Toggle the lock/unlock state of the layer.

Delete Remove layer from the main screen.

» Auxiliary area

Auxiliary area displays the available input sources, which can be dragged into the

main screen above.

8.2 Adjustment

8.2.1 Pipeline Tile

* When there is no input source in the output area of the layout properties, the

adjustment tile is displayed as follows.

ADJUSTMENT

Figure 8.2-1 Pipeline tile

» When there is at least one input source in the output area of the layout properties,

the adjustment tile appears as follows:

ADJUSTMENT

Figure 8.2-2 Pipeline tile
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8.2.2 Properties

Global adjustments

ADJUSTMENT

Global adjustment

HDR format

SDR ( PQ ) HLG

[[] PQ maxCLL override 1000Nits

PQ gain 1.00

. —

|:| P auto brighten

Figure 8.2-3 Global adjustments
» HDR format: It supports SDR, PQ or HLG.

e PQ maxCLL override: Allow the maxCLL value to be specified by the user (when

ticked) for incoming PQ content.

e PQ gain: A multiplier adjustment to all brightness levels of the incoming PQ

content.

* PQ auto brighten: Automatically adjusts the brightness of incoming PQ content to

match the brightness capabilities of the LED panels being used.

» HDR dynamic calibration: It compensates for the loss of brightness before and after

calibration.

Color space

Figure 8.2-4 Color space

» Dynamic color gamut button: Click this button to enter the dynamic color gamut

interface.

» Drop-down box of Color space is used to set color space parameters of the input,

which is only displayed after dynamic color gamut is enabled.

61



rl':.cmoﬂight ColorAdept User Manual

* Input InfoFrames override color space when present: It indicates that the system is
forced to use the color gamut specified by the metadata sent through the information

frame, which is only displayed after dynamic color gamut is enabled.

Input adjustments

Input adjustment

Available input

1-HDMN
1-HDMIZ

Figure 8.2-5 Input adjustments

* Input selection list: Displays adjustable input sources.

The following is a display of the corresponding properties of the selected input source.

SDI Basic information

er channel

Format 3G

Figure 8.2-6 SDI

 Status: The status (includes no signal and signal locked) of the input source signal.
» Resolution: The resolution of input.

e Frame rate: The frame rate of input.

» Sampling: Chroma subsampling compression of incoming source.

* Bit depth: The bit depth of the incoming content.

* Format: SDI input format.

Low latency

Figure 8.2-7 Low latency

62



'E‘vColorlight ColorAdept User Manual

» Low latency: It reduces the delay time from the input video source, processor to
the LED display. When low latency is enabled, the input video source is preferred to
select as the Genlock source (when there are multiple input video sources, they

should be synchronized).

The following control items can be adjusted by slider or manual entry.

» Black Level: This control affects the base level brightness of darkest content of the
input. Modifying this value will affect the signal gradually, but it is the most

pronounced at the lower end of the video signal nearest black.

» Contrast: It controls the difference in brightness between the darkest content and

brightest content.
* Hue: Adjusts the spectrum of the incoming video feed.

» Saturation: Adjusts the depth of the color.

Black level

Figure 8.2-8 Color control

» Red Highlight: It is for adjusting the contrast of red (white level).

» Green Highlight: It is for adjusting the contrast of green (white level).
 Blue Highlight: It is for adjusting the contrast of red or blue (white level).
* Red Shadow: Setting the black level of red for the selected input.

» Green Shadow: Setting the black level of green for the selected input.

» Blue Shadow: Setting the black level of blue for the selected input.
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Red highlight

Green highlight

Elue highlight

Green shadow

Blue shadow

Figure 8.2-9 Color control

EdNote:
The RGB highlight and shadow sliders are equivalent to the settings of RGB white level and black

level respectively.

HDMI/DP Basic information

 Status: The status (includes no signal and signal locked) of the input source signal.
» Resolution: The resolution of input.

* Frame rate: The frame rate of input.

* Sampling: Chroma subsampling compression of incoming source.

» Bit depth: The bit depth of the incoming content.

e HDR status: It shows HDR format, color space, and Max CLL. HDMI/DP is displayed
as no signal when there is no signal input source. (The following information is

supported to be expanded/collapsed which is collapsed by default.)

* Format: Itis used to author the incoming content, which can be SDR or PQ or HLG.
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Frame rat
Sampling

Bit depth

Blue target 0

White target 0.3

Figure 8.2-10 HDM{/DP
The following information is displayed as unspecified when there is no HDMI/DP
signal.
» Colorspace: Itis the color space used for incoming HDR content.

* Minimum Display Mastering Luminance: The minimum display panel luminance for

which the HDR content has been authored.

¢ Maximum Display Mastering Luminance: The maximum display panel luminance

for which the HDR content has been authored.

e Maximum Content Luminance Level: For incoming HDR content, it displays the

maximum luminance level that any single pixel is expected to achieve.

* Maximum Frame Average Luminance Level: It displays the maximum average

luminance level of any single frame for incoming HDR content.

* Red Target: The red point target coordinates to which the incoming HDR content

that has been authored.

» Green Target: The green point target coordinates to which the incoming HDR

content that has been authored.

* Blue Target: The blue point target coordinates to which the incoming HDR content

that has been authored.
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» White Target: The white point target coordinates to which the incoming HDR

content that has been authored.
ST2110 Basic Information

» Status: It displays the input status, including no signal and SFP1/SFP2 signal

locked;

* RJ45: It shows the connection status of RJ45, including unconnected and

connected;
* Network protocol version: It provides network protocol versions of IPv4 and IPv6;

» SFP1: It displays the video stream and audio stream contained in the incoming

SFP1;

» Video stream IP: It displays the IP address and port number of the video stream in
SFP1;

» SFP2: It displays the video stream and audio stream contained in incoming SFP2;

» Video stream IP: It represents the IP address and port number of the video stream

in SFP2;
» PTP status: It shows the status of the server, including online and offline status;

* Synchronization status: It shows the frame synchronization status between
different ST2110 sub-boards (cross-processor available), which includes synchronized

and unsynchronized status;

* Resolution: Resolution of the incoming source signal;

* Frame rate: Frame rate of the content being received from the source;

» Sampling: Chroma subsampling compression of the incoming content;
* Bit depth: Bit depth of the incoming content;

» HDR status: This always shows the HDR format, color space and Max CLL. It
displays as no signal when ST2110 signal is lost or unconnected (You can choose to

hide/show the information below, which is hidden by default).

» Format: The HDR format is used to author incoming content. Can be SDR, PQ or

HLG.
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The information below is displayed as unspecified if there is no signal in ST2110 port.
» Color space: Color space used for the incoming HDR content.

* Min Display Mastering Luminance: The minimum display panel luminance for

which the HDR content has been authored.

* Maximum Display Control Brightness: The maximum display panel luminance for

which the HDR content has been authored.

¢ Maximum Content Light Level: The maximum light level that any single pixel is

expected to achieve for the incoming HDR content.

» Maximum Frame Average Light Level: The maximum average light level for any

single frame of incoming HDR content.

* Red Target: Red target coordinates to which the HDR content that has been

authored.

» Green Target: Green target coordinates to which the HDR content that has been

authored.

* Blue target: Blue target coordinates to which the HDR content that has been

authored.

» White target: White target coordinates to which the HDR content that has been

authored.

EDID
EDID
Custom w

Width Height Frame rate

2560 T 1600 _  144.000

Bit depth

(‘8bit ) 10bit 12bit

Figure 8.2-11 EDID
» Resolution and frame rate of EDID can be customized.

+ Bit depth: Support 8bit, 10bit and 12bit.
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Low latency

- Input ds to be set a
- Multiple inputs must be syn:

Figure 8.2-12 Low latency

e Low latency: It reduces the delay time from the input video source, processor to
the LED display. When low latency is enabled, the input video source is preferred to
select as the Genlock source (when there are multiple input video sources, they

should be synchronized).

Color format

Color format

(From input) RGB YCbCr4:4:4 YCbCr4:2:2

Figure 8.2-13 Color format
» Color format: Available options include: From input, RGB, YCbCr4:4:4, and

YCbCr4:2:2.

Quantization range

Quantization range

(From inpu’_c'- Limited to full

Figure 8.2-14 Quantization range
* Available options for Quantization range include: From input and Limited to full.

The following control items can be adjusted by slider or manual entry.

» Black Level: This control affects the base level brightness of darkest content of the
input. Modifying this value will affect the signal gradually, but it is the most

pronounced at the lower end of the video signal nearest black.

» Contrast: It controls the difference in brightness between the darkest content and

brightest content.
* Hue: Adjusts the spectrum of the incoming video feed.

» Saturation: Adjusts the depth of the color.
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Black level

Figure 8.2-15 Color control

» Red Highlight: It is for adjusting the contrast of red (white level).

» Green Highlight: It is for adjusting the contrast of green (white level).

» Blue Highlight: It is for adjusting the contrast of red or blue (white level).
* Red Shadow: Setting the black level of red for the selected input.

» Green Shadow: Setting the black level of green for the selected input.

* Blue Shadow: Setting the black level of blue for the selected input.

Red highlight

Green highlight

Blue highlight

Red shadow

Green shadow

Blue shadow

Figure 8.2-16 Color control

» Balance settings (HDMI only): This setting is displayed only when Advanced mode

is turned on.

A

Balance settings

Figure 8.2-17 Balance settings
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9 Color Processing

The color processing section in the pipeline consists of Color Magic, Curves, and 3D

LUT.

PROCESSING

COLOR MAGIC CURVES

Figure 9.1-1 Color processing tiles

9.1 Color Magic

Color magic allows you to manipulate single or multiple predefined colors without

affecting other colors.

@® COLOR MAGIC

Figure 9.1-2 Color magic

The inner ring is divided into 12 colors and red is selected by default. When the cursor
is placed on a certain color, the color is convex to indicate it is clickable. When you
clicked, the color is displayed concave to show that the color has been selected. After

selecting a color, the H, S, and V values of the color can be set.
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Parameter comparision

Figure 9.1-3 HSV

Expand the parameter comparison charts to check the offset of each color component

more intuitively corresponding to H, S, and V.

Whilte

R

Figure 9.1-4 HSV offset

Black and white are adjusted via RGB gains.

9.2 Color Curves

Color curves permit to control the video level of each color channel by creating

custom transmission curves.

71



rl':.cmoﬂight ColorAdept User Manual

@® COLOR CURVES

Figure 9.2-1 Color curves

Color curves are employed to provide brightness, red, green, blue channel curves.
After selecting the curve of the desired channel on the bottom of the graph, you can

select any point on the curve and drag it to the desired position.

9.33D LUT

3D LUT is an efficient way to map colors and allowed for advanced color correction. It
is commonly used in film production, from on-set camera adjustments to color

grading in post-production.

File
Jfad0abec212378e1b

Title

Strength

Figure 9.3-13D LUT

Only one 3D LUT file can be loaded into the project once.

3D LUT strength is controlled by the strength slider. The strength of 0% is equivalent
to the effect before enabling the 3D LUT and a 100% intensity is equivalent to the
effect after enabling the 3D LUT.
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10 Override

The override section in the pipeline area contains three parts of test patterns, freeze

and blackout.

OVERRIDE

* QO

PATTERMN BLACKOUT

Figure 10.1-1 Override pipeline tiles

10.1 Test Patterns
To activate test patterns:

» Double-click on the Pattern pipeline tile.
* Click the enable button on the property editor title bar.

* Click the desired test pattern.

@® TEST PATTERN

Figure 10.1-2 Test pattern

» Speed: This function is applicable when you select four test patterns of scrolling
grid, scrolling 45° grid, scrolling checkerboard, and scrolling gradient. Speed can be

adjusted by dragging the slider or clicking spin button, and the value range is 1~100.

* Spacing: This function is available when you select four test patterns of grid,

scrolling grid, 45° grid, scrolling 45° grid. It can be adjusted by dragging the slider or
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clicking spin button, and the value range is 8~1000.

» Gradient stretch: It's usable when you select test patterns of gradient, scrolling
gradient. It can be adjusted by dragging the slider or clicking spin button, and the

value range is 1~32.

Figure 10.1-3 Test patterns adjustment

Custom color test pattern allows on-screen color display improvement by adjusting

RGB values only.

Custom color

Red

Green

Figure 10.1-4 Custom color

10.2 Freeze

Enable Freeze to pause the incoming video signal and hold the final frame indefinitely

until the freeze is disabled.

@® FREEZE
Figure 10.2-1 Freeze

I

10.3 Blackout

Enable Blackout to make all screens display black and disable the blackout function
to resume live video.

Figure 10.3-1 Blackout
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11 Output

11.1 Global Color

» Brightness: Brightness slider allows adjustment for light output on the cabinets.
Since all cabinet types are calibrated while writing the configuration file, the
brightness slider is expressed in Nits. This means that arrays with different cabinets
can be quickly set to the same output level. If you use more than one cabinet type
with different maximum brightness values, the brightness slider defaults to the

brightest value that can be reached by all cabinets in the project.

» Overdrive: Once overdrive has been enabled the slider will allow the
brightness of the panels to be pushed to the brightness limit of the LEDs within
the panels.

= Qverwrite: Overwrite the maximum brightness value of the cabinet to prevent

the cabinet brightness overload.

» Color temperature: It is employed to modify the color of the LED display. It allows
users to adjust the white balance of attached cabinets in a range of 2000~11000K. By
default, the value is 6504K.

* Gamma: Gamma adjustment is a way to adjust brightness of mid-tones in the
image without affecting very dark or very bright areas of the image. A higher value

results in lower brightness overall.

GLOBAL COLOR o £

Brightness 2250Nits
==

Override

s Color temperature 6504K
(i —

[:l Dynamic color temperature adjustment

Gamma 2.80

Figure 11.1-1 Global color
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 Infi-bit: It is used to improve the low grayscale transition, so that more grayscale

and low gray information can be displayed on the screen.

» Grayscale refinement: It is applied to eliminate the grayscale jump of the screen

display, making the grayscale transition smoother.

» Low grayscale optimization: This function is used to optimize the low grayscale

display effect to make the screen display more delicate.

Light turbo

(] Infi-bit

|| Grayscale refinement

[:l Low YSCate o [:itlr'l'liZEtiE: n

Figure 11.1-2 Light turbo

* Intensity gain: It allows users to modify the brightness of input source. The
intensity output of all cabinets will change in a linear way. When the intensity output
is adjusted to 50%, the cabinets will look half as bright to the naked eye as they did at
100%. The precise light output of the screen is determined by this value in conjunction

with the value of the brightness slider.

* RGB gain: It modifies the level of each primary color in the cabinet output. Their
default value is 100%. Adjusting all 3 RGB gains to 50% has the same effect on

brightness as lowering the intensity gain to 50%.

Intensity gain
Red gain
Green gain

Blue gain

Figure 11.1-3 Intensity and RGB gains

 Calibration mode: Both brightness calibration and chroma calibration are available.

Calibration mode

Dizable

|:| Thermal effects removal
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Figure 11.1-4 Calibration

e Thermal Effects Removal: Tick to remove thermal effects.

* Panel temperature: Choose From sensor or Custom as you need.

Thermal effects removal

Panel temperature

From sensor (Custom )

Figure 11.1-5 Thermal effects removal - Panel temperature

» Cabinet color adjustment: Only available when Advanced mode is enabled. Tick

the box to enable this function.

g Cabinet color adjustment

Figure 11.1-6 Cabinet color adjustment

» Peak brightness adjustment: Tick the box to enable this function.

s Peak brightness adjustment 8

Figure 11.1-7 Peak brightness adjustment

» Dynamic color gamut: Click the thumbnail to be taken to the dynamic color gamut

interface.

Dynamic color gamut

I

Figure 11.1-8 Dynamic color gamut

* On-screen color management: Click the thumbnail to enter OSCM mode.

On-screen color management D

Figure 11.1-9 On-screen color management

11.2 Network

The NETWORK properties can be further divided into General and MAGIC.
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11.2.1 General

Video

* Network bit depth: By default, the network bit depth is 10bit, which can be
changed to 8bit or 12bit. Lowering the network bit depth allows more panels to be

connected to the processor.

« Additional video delay: It allows the output refresh to be delayed up to 3 frames,
which allows the processor to match the latency present in other display systems.

Additional video delay is grayed out when Zero latency is enabled.

» Zero latency: Select the checkbox to enable Zero latency.

LdNote:
When Zero latency is enabled, the control area of a single port can only be confined to a single layer.
The input video source is preferred to select as the Genlock source (when there are multiple input

video sources, they should be synchronized).

NETWORK
=] General

Video

Additional video delay 0 _ frames

D Zero latency

is enabled:

) urce.
- Multiple inputs must be synchronized.

Figure 11.2-1 Video

Genlock

e Internal: It allows users to customize output frame rate of the processor, which
ranges from 23.5~251Hz. The processor will automatically compensate sources where

the source frame rate and the internal refresh rates are different.

e Lock input source: The processor can lock its refresh rate to the input source and it
will automatically compensate for sources whose frame rate does not match the

refresh rate of the selected source.

o Ref In: Stand for external synchronous signal. The processor will automatically
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compensate for sources that do not match the external reference refresh rate.

e Multiplier: The frame rate of the external Genlock source multiplied by the
customized multiplication factor acts as the frame rate of Genlock source. It is
displayed only after enabling Advanced mode and it is disabled by default. The factor
can be set to 2~10.

* Phase Offset: The phase offset permits fine control of LED screen timing to rectify

visual artifacts displayed on the panel relative to the selected Genlock source.

* Angle: This specifies the desired delay as an angle relative to a full circle. For
example, an angle of 180° corresponds to 1/120th of a second with a 60Hz
Genlock source.

» Fraction: This is specified as a proportion of the Genlock source' frame period.
For example, with a 60Hz Genlock source, a fraction of 50% corresponds to
1/120th of a second.

The output frame rate of the Genlock signal can be calculated by angle or fraction
settings. These delays can be specified as positive or negative values. Using a negative
value, adjust the sync point by adding latency of the input video signal. For example, a

phase offset of -10% delays incoming video frames by 10% of the frame period.

Genlock

Source

®) |nternal

T-HDOMIT
I_J Refln Mot locked
Phase offset

Mone bl

Figure 11.2-2 Genlock

System load

This bar indicates the current load of the processor. The larger the current load, the
more the bar is filled with green. When the current load exceeds the processor s

capacity, the bar will change its color to red.
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Figure 11.2-3 System load

Video delay
This area shows the delay frame of the online inputs. To view this area, you should
enable Advanced mode first.

Video delay

1-HDMI1 1 frames
1-HDMI2
2-DP1

2-DP2

Figure 11.2-4 Video delay

11.2.2 MAGIC

Frame rate multiplication
It multiplies the incoming Genlock signal.
+ Off: Disable multiplication.

» Automatic: If the frame rate of Genlock signal < 24.61Hz, it will be multiplied by 3
times. Similarly, > 24.61Hz and < 49Hz for 2 times. Except for > 49Hz, which is not
multiplied.

» Specify: The default value is 2 and the value ranges from 2 to 10.

» Frame multiplexing: It allows users to interleave different areas of input video
raster, solid colors, or image into the output of the LED panel display. At its most
simple frame multiplexing permits the output frame rate to be doubled so that a black
frame can be inserted directly into each frame of the actual content, which is a useful

technique to reduce motion blur.

» Multiplier: The default value is 2 and the value ranges from 2 to 10.
* Enable frame multiplexing, and each (up to x10) output frame can be
configured to display video content, colors or images.

* Normal/Invert is available for each output subframe. After enabling
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Normal/Invert, you can set the brightness of the subframe.

Frame rate multiplication

1e multiplexing

Multiplier

1 [Videe ¥ X 0

Off v

Color v

Normal v

Figure 11.2-5 Frame rate multiplication
* 3D:Single 3D or Dual 3D modes are available.

» Single 3D: Set the input source, source format, eye priority and signal delay to

simulate the actual viewing effect by human eyes.

= Picture: Your left eye corresponds to the input source layer and right eye
selects the input source according to the actual situation.

» Source format: The source format should be set when the left eye and the
right eye use the same input source. Set the format as left/right or top/bottom
according to the video source.

= Eye priority: Set the correspondence between video display and opened lens.
» Signal delay: Delay in the arrival of the signal transmitted through the 3D

interface relative to the Vsync signal.

dNote:

Support single 3D of multiple inputs. After enabled, the total band load is reduced by half.

» Dual 3D: You are able to watch different 3D videos from the same screen using

different 3D glasses.

" Glasses: The left eye of Glasses 1 corresponds to the input source layer, and

the input source of right eye can be selected according to the actual situation. The
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input source of the left and right eyes of Glasses 2 are selected according to the
actual situation.
» Eye priority: Set the correspondence between video display and opened lens

by drag and drop.

EdNote:
Source format and signal delay features are the same as single 3D. There is only one input layer for

dual 3D. When dual 3D is enabled, the total bandwidth will be reduced by three quarters.

Mode
Dual 3D
Glasses 1

Left eye 1 (L1) Right eye 1 (R1)

Glasses 2

Left eye 2 (L2) Right eye 2 (R2)

video display and

Signal delay (ns) 03, 884, 000

Figure 11.2-6 Frame rate multiplication

ShutterLock

This feature enables the processor to tune the LED panel refresh rate for optimal
performance to the camera. This helps prevent unsightly artifacts such as scanning
multiplexed lines and poor exposure, as the camera is not open long enough to

capture the complete PWM cycle of the LED panel.
» Speed: Manually set shutter speed (1/x) or exposure time.

» Angle: Shutter angle and camera frame rate entry (used to calculate the resulting

exposure time).
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Shutterlock
Shutter mode

Angle

Shutter opening pos

Front of Genlock
Shutter angle
Camera frame rate

| Match Genlock | Custom

( Global shutter ) Rolling shutter

| Mar
the

Figure 11.2-7 ShutterLock

Virtual pixel

Set virtual pixels of the cabinet to let the LED screen deliver a better display effect.

» Mode: Select 4x virtual, 3x virtual, or 0.75x virtual as desired.

* Routing: Select Up to down or Left to right.
* Row offset: Choose between None and Upward.

» Column offset: Choose between None and Leftward.

Virtual pixel
Virtual mode
4x virtual
outing
Ip to down-:_;_:.' Left to right

Row offset

None ) Upward

Column offset
Leftward

) Some of the associated panels cannot
achieve the requested performance.

Figure 11.2-8 Virtual pixel
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11.3 Failover

Processor redundancy

Role (selecting primary/backup means processor redundancy is enabled)
« Off: Processor redundancy is not enabled by default.

* Primary: Indicates that the current processor is the primary processor.
* Backup: Indicates that the current processor is used as a backup.

VSync is not allowed to switch to other inputs or auto-generated frame rates (only
shown when Advanced mode is enabled). Unticked by default. When ticked and an
unlocked input is selected as Genlock, it is not allowed to switch to other inputs or

auto-generated frame rates.
Behavior
Only displayed when Advanced mode is enabled.

» Always prefer primary if available: The backup processor takes control if the output
of primary processor fails. The primary processor will automatically switch back to

take control when the failed output becomes available again.

* Primary only

» |If the current processor is the primary, all port outputs of the primary
processor will be enabled. Even if the port failure of primary processor occurs, it
will not be switched to the backup processor.

» |fthe current processor is the backup, all port outputs of the processor will be
disabled.

» Select this option to detect whether the current processor has a failed port.

» Backup only

» |fthe current processor is the primary, all port outputs of the processor will be
disabled.

» |f the current processor is the backup, all port outputs of the backup
processor will be enabled. Even if the port failure of backup processor occurs, it
will not be switched to the primary processor.

= Select this option to detect whether the current processor has a failed port.
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Cable redundancy

FAILOVER

Processor redundancy

Role

Off -F'rir'r'|ar_-,-: Backup

— inf ame rate
Behavior
vays prefer primary if available

mary only

Figure 11.3-1 Processor redundancy

It is displayed only when the processor redundancy is turned off and at least one

option is checked to turn on the cable redundancy. Both fiber port and network port

redundancy are available.

Output ports of the processor are listed according to the actual condition and these

options follow the principle of "even number ports serve as the backup of odd

number ports".

Cable redundancy (Primary & Backup)

[ selectall

|| Port 18 Port 2

(] Port 3 & Port 4
[:| Port 5 & Port 6

[ Port 7 & Port 8

Figure 11.3-2 Cable redundancy
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12 Dynamic Color Gamut

Dynamic color gamut can be applied to match the actual color gamut and target color

gamut of display to achieve the ideal display effect.

There are three ways to enter dynamic color gamut interface:

* Dynamic color gamut button H in the Adjustment property area.

* Dynamic color gamut button n at the bottom of the global color property area.

* Dynamic color gamut option H in the Tools menu list.

Figure 12.1-1 Dynamic color gamut interface

Dynamic color gamut toolbar

o Exit RRMEG: Fxit the dynamic color gamut interface and return to the main project

interface.
 Undo .: Same as the undo button in canvas toolbar.

Redo .: Same as the redo button in canvas toolbar.

s Zoom out: Adjust the horsehoe diagram to appear smaller.
e Zoomin : Adjust the horsehoe diagram to appear larger.

e Zoom to fit : Zoom to display the full size of the horsehoe diagram in the center

of the screen.
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» Standard color gamu : The standard color gamut which is displayed as the

corresponding dotted triangle is shown in the horsehoe diagram by default.

When the following color button is clicked, the screen will display the test pattern of

that color. Clicking the display video button will disable the test pattern.
» White, red, green, blue, cyan, magenta, yellow.

Horsehoe diagram
 Video Input color gamut (input source color gamut): It consists of three small dots

(not linked); if there are multiple input sources, the same specified color gamut is used.

* Panel output color gamut (target color gamut): It is comprised of three small

squares (not linked).

 Display color gamut: It's defined according to the actually selected cabinet, as the

rainbow area shown below.

Figure 12.1-2 Horsehoe diagram

Property
» Dynamic color gamut switch: When disabled, the original color gamut of the input

source is applied directly as the output color gamut.

* Brightness: Same as the brightness in the global color property.

@® DYNAMIC COLOR GAMUT

Brightness BOONits

Figure 12.1-3 Dynamic color gamut
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Video input color space

e It is allowed to quickly switch to the Rec.2020/DCI-P3/Rec.709 color gamut by
selecting the drop-down box. The color gamut can be customized by modifying the

coordinate values of RGBW.

* Input InforFrames override color space when present: It indicates that the system is

forced to use the gamut specified by metadata sent through the information frame.

Video input color space

Custom

Red
Custom
Green
Custom
Blue
Custom
White

Custom

Figure 12.1-4 Video input color space

Panel output color space

» When you select a cabinet type from the cabinet type list, the color gamut of panel
output (consisting of three small squares) is displayed in the color gamut horseshoe

chart.

» Select drop-down box options:

= Match input: Use the same color gamut of video input.
» Achievable: Use the achievable color gamut for the selected cabinet type.

= Custom: Allow users to define a customized color gamut.
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Panel output color space

TVFO.9

Match input
Red

Figure 12.1-5 Panel output color space

The video input color gamut and panel output color gamut can be edited in the

following three ways.

» When hovering the cursor over the settings box, modify the target value by

scrolling the mouse wheel.
» Modify target values via keyboard input.

* Modify the input/output target values by dragging the dots/squares in the color

gamut horseshoe diagram.
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13 OSCM

OSCM is an abbreviation for On-screen color management. In OSCM mode, the
brightness of the module or cabinet seams can be adjusted to be consistent with the

rest of the LED screen.
OSCM mode can be accessed in the following two ways.

 Click on-screen color management thumbnail located at the bottom of the global

color property area =81,

o [
» Select on-screen color management options in the Tools drop-down menu .

=} | 4 ; | | | HE O sy * @ sEAMs
PP F3 FA F5 6 H B A 5 D F G H v =

Figure 13.1-1 OSCM

 If the video output is currently in use, putting the processor into OSCM mode will

disable the video output.

* The OSCM window displays the cabinets as they are positioned on the canvas.

OSCM Toolbar

« Confirm button -: After adjusting the seams, click this button to save the

modifications in OSCM mode and return to the main project interface.

* Cancel button .: After adjusting the seams, clicking this button will cancel the

modification in OSCM mode and return to the main project interface.

Seam Types

W]
» Select horizontal and vertical seams : Seams of all modules can be selected.
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* Select horizontal seams only E: Horizontal seams of modules can be selected

only.
» Select vertical seams only M: Vertical seams of modules can be selected only.
» Select seams on panel edges D: All seams of the panel can be selected.

» Select horizontal seams on panel edges :: Horizontal seams of the panel can be

selected only.

» Select vertical seams on panel edges H: Vertical seams of the panel can be

selected only.

Cabinet/Module type

* Select module : Adjust color by module.

» Select cabinet : Adjust color by cabinet.

LdNote:
Multiple seams, cabinets, and modules can be selected using Ctrl + click or click + drag the left

mouse button to create a selection box around the seams.

Figure 13.1-2 Seam types/Color adjustment

Color

e In OSCM mode, the processor will output a solid color on all connected cabinets.
White is displayed by default, and red, green, blue, cyan, magenta, and yellow are also

supported.

Layer

* You can switch to show or hide the corresponding tier of the display, making it

easier to select seams in the cabinet or module.

Figure 13.1-3 Color
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Seam property

SEAMS: Switch this toggle button to enable/disable Seam adjustment.
Calibration mode: Multiple calibration modes are available.
Brightness: It is the same as the brightness in the global color properties.

Seams adjustment

* Brightness: Adjust the overall brightness of the selected seams.

= Start luminance: Adjust the brightness of left part of horizontal seams or the
top of the vertical seams.

* End luminance: Adjust the brightness of the right part of the selected

horizontal seams or the bottom of the vertical seams.

Brightness 4000Mits

Seam adjustment

P 1
S| l+—F—]

End luminance (3++/—)

Figure 13.1-4 Seam adjustment

Color adjustment

* RGB gains: Click or B to access the color adjustment interface to increase or

decrease the RGB gains of module or cabinet.
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» Click to enable linkage, which allows you to adjust the Red gain, Green gain,

and Blue gain simultaneously.

m RGB gains @ O

Red (1+/-) 1.0000

Green (2+—/—) 1.0000
e——
Bule (3+«/—) 1.0000

Figure 13.1-5 Color adjustment

 Fine control: Enabling fine controls gives users the finest amount of control.

] Fine controls

Figure 13.1-6 Fine control
Do any of the following to adjust seam brightness value or RGB gains:

» Press and hold the shortcut key and use either the +/- keys or right/left arrows on

the keyboard to increase/decrease the luminance.
* Click + drag the wheel to the left/right to increase/decrease the luminance.

» Hover the cursor over the wheel and use the mouse wheel to scroll up/down to

increase/decrease the luminance.
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14 Multiple Processors Control/Chief-Member Mode

Interface

14.1 Multiple Processors Control Interface

The multiple processors control interface allows freeze, blackout, some parameters

controlling and preset switching functions for multiple processors at the same time.
How to enter the multiple processors control interface:

* Click on a group with processor included in the processor list.

» Multi-select processors/groups in the processor list via Ctrl/Shift.

Figure 14.1-1 Multiple processors control interface

» Every time you enter the multiple processors control interface, all parameters in
the interface are the values from the opened project of the first processor in the
processor list. If there are no opened projects in the selected processors, all

parameters in the interface are displayed as default values and grayed out.

» When you change the parameters, only the processor parameters of the opened

project are modified accordingly.
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14.2 Chief-Member Mode Interface

Access: Preferences... > Advanced > Chief-Member mode

Figure 14.2-1 Access to Chief-Member mode

» Tick the box Chief-Member mode to enable this mode. In this mode, changes to the

chief processor’ s parameters will be synced to the member processors.

 Setting interface: You can select a processor as the chief one, and then select any of
the sections shown in the lower interface to allow synchronization of the parameters

in that section(s) from the chief processor to the member processors.

Figure 14.2-2 Chief-Member mode’ s setting interface

 Chief: Select a processor as the chief one.

« B click this icon to jump to the interface for the project processed by the chief

processor.

* In Chief-Member mode, the chief processor’ s parameters that can be synced to
member processors are further divided into 10 sections. Each section has an icon E
at the upper right indicating the synchronization status of the parameters in it. When
the icon is displayed in orange, changes to the parameters in that section will be

synced to the member processors.
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15 Status Bar

The status bar is located at the bottom of the software interface.

Figure 15.1-1 Status bar

* On the left, there is a prompt for important operations. For example, when the
cursor is placed in the main view under add cabinets mode, it will display as "Click to

add cabinet, click + drag to add an array, Escape to finish".
 Inthe middle of the status bar, it shows the prompt of success/failure of operations.

» Theright part of status bar exists the prompt of Genlock source.

16 Notification Center

When there is only one notification, it is displayed in the upper right corner of the
software by default and can be dragged around. The notification center is used to view

notifications for all processors or the current processor.

Figure 16.1-1 Notification center

» Switching button: Switch to display the notifications between all processors or

current processor.
 #: This always shows the number of current notifications and sequence number.
* Details: The detailed information of the notifications.

» Correct cabinet type: Click to automatically correct the mismatched cabinet

types in the canvas.

* Go to: Click k==d to go to the relevant interface of the processor.
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17 Multi-function Card

Access: Menu bar - Accessories- Multi-function card.

Accessories

[ Multi-function card

= 3D-Box

Figure 17.1-1 Accessories - access to multi-function card

* Refresh: Refresh information of the detected multi-function card.

1B 12345  Coloidept g X

Figure 17.1-2 Accessories - Multi-function card interface

17.1 Multi-Function Card List

This list shows the information of the multi-function card, including its type, version,
and the processor and port connected to it.

Version Processor
1.23 Simulator

Simulator

Simulator

Simulator

Figure 17.1-3 Multi-function card list
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17.2 Control Set

The control set is used to set the processor network ports controlled by the multi-

function card.
+ AddmM:Add disassociated processor to the associated processor list.

* Delete : Remove the selected processor from the associated processor list.

Sensor information ntro Auto brightness adjustment

Associated processor(1) Disassociated processer(0)

1/1 pieces
| RGT

. Simulator

Figure 17.2-1 Add disassociated processor

» Associated processor list: Display the name, IP, and number of controlled

ports/total ports of the associated processor.

" You can select the processor port you need to control in the list.

» Disassociated processor: A processor that is not controlled by the multi-function

card is displayed in the disassociated processor list.

17.3 Sensor Information

* Onboard Sensor: Display temperature and humidity values detected by onboard

Sensor.

» External Sensor: Display information detected by external sensor.

3 Note:

When at least two sensors are connected to a port via a docking station, "Port X-X" is displayed

depending on the actual connection.
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Control set Se on ower contro Auto brightness adjustment

Onboard sensor

Temperature

Humidity

External sensor

28462 Lux

Figure 17.3-1 Sensor information

17.4 Power Control

The power supply is turned on/off by relay in the multi-function card.

» Time: Display the internal time of the multi-function card.

* Read Time: Read the time of the multifunction card and refresh the "Card time".
» Sync PC time: Synchronize the time of multi-function card to your PC time.

» Reset: This option shows only when the mouse cursor hovers over this power
control area. Reset function restores Auto control switch, Auto control settings, Timing

control switch, Timing control settings, and interval time to default values.
Sensor information P Auto brightness adjustment
Card time 2 7 20:12:56 Read time Sync PC time

LED s

[ Aute control

Figure 17.4-1 Power control
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LED Screen Power Supply
Relay 1~4 control the on/off of LED screen power supply.

* Close/Open: Click the button to send the corresponding command. The relays will

be closed/opened by the time interval in sequence.

» Relay status: Green indicator stands for closed status and gray for open.

LED screen power supply

Close  Open

&

|:| Auto control

[_| Timing contral
Interval
1s

2} Thetimeb each relay for

Figure 17.4-2 LED screen power

* Auto control switch: Automatic control can be enabled by this switch.

» Auto control settings: It is used to monitor video input, smoke, temperature, and

will automatically open/close the relay when conditions are met.

= Relay selection: Select the relay you want.

= Video input control: It will open the relay when there is no video input and
close the relay when the video input is restored.

* Smoke control: The relay will be opened when the smoke value is greater than
the preset value.

» Temp control: The on-board sensor temperature or external sensor
temperature is available. The relays will be opened when the temperature is
greater than the preset value and remain open when the temperature is less than

the preset value.
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Temp control

Temp from (Onboard s ternal sensor

Figure 17.4-3 Auto control settings
» Timing control switch: Automatic control can be enabled by this switch.

» Timing control settings: It allows you to add commands to close or open the relay

by scheduling.

* Add command: Add close/open commands and you can specify command

execution time and effective date.

» Edit command: Edit the execution time and effective date of close/open

command.

= Delete command: Delete the command.

Command Execution time Effective date

Add command

Command Close g Execution time

Effective date

| Every day | Custom

Repeat

Cancel

Figure 17.4-4 Timing control settings

* Interval: Set the interval for opening or closing the four relays.
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Other Power Supplies

Relay 5/6/7/8 controls the on/off of remaining power supplies except LED screen

power supply.

* Rename Button: This button is displayed only when the mouse cursor is hovering

over the power supply area.
» Auto control switch: Automatic control can be enabled by this switch.

» Auto control settings: It is used to monitor smoke, temperature, and will

automatically open/close the relay when conditions are met.

* Relay selection: Select the relay you want.

* Smoke control: The relay will be opened when the smoke value is greater than
the preset value.

» Temp control: The on-board sensor temperature or external sensor
temperature is available. The relay will be opened/closed when the temperature
is greater than the preset value. The relay will be opened/closed when the
temperature is 2°C lower than the preset value.

» Sync to relay: You can sync the current settings to the other relays except relay
1-4.

Sensor information Po ntro Auto brightness adjustment
6] Auto control settings

Relay 5 ™

Smoke control

Smoke exceeds 600ppm v ,open relays. Drop: 0ppm, remain open.

Temp control

Temp from (Onboard sensor ) External sensor

Temp exceeds 0T i Open ~  relays. Drops belo

Figure 17.4-5 Other power supplies-auto control settings
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17.5 Auto Brightness Adjustment

After enabling auto brightness adjustment, the multi-function card will automatically
adjust the LED screen brightness according to the ambient illuminance captured by

the brightness sensor.

¢ Adjustment mode: There are 4 adjustment modes.

Figure 17.5-1 Auto brightness adjustment interface

» Linear mode: Three points on the line are adjustable.

Figure 17.5-2 Linear mode
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= Gamma: Two points on the curve are adjustable.

Figure 17.5-3 Gamma mode

* |nverse-Gamma: Two points on the curve are adjustable.

Figure 17.5-4 Inverse-Gamma mode
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= Custom: Nine points on the curve are adjustable.

Figure 17.5-5 Custom mode

* Reset button: Reset the coordinate of points in the current adjustment mode

to default values.

» LED screen brightness: It allows you to set the LED screen brightness, which takes

effect when an abnormality occurs in the ambient illumination capture.
LED screen brightness

ffect when there is an
ormality in the ambient

illumination capture.

Figure 17.5-6 Reference value of ambient illumination
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18 3D-Box

Access: Menu Bar > Accessories > 3D-Box

Accessories

1 Multi-function card

&= 3D-Box

Figure 18.1-1 Access to 3D-Box

» Refresh: Click to detect 3D-Box and refresh the list below.

Figure 18.1-2 Interface of 3D-Box

3D-Box List

This list shows the information of the 3D-Box, including its type, the processor and

port connected to it, FPGA, ARM, and the board’ s temperature.

Processor Board temp
Simulator
Simulator

Simulator A 1.0(1G)

Simulator 4 1.0(1G) 1.0(SV

Simulator 1.001G) 1.0(SVN ¢

Simulator 2 1.0(1G)

Simulator 3 1.001G)

Simulator - 1.0(1G)

Figure 18.1-3 3D-Box list
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